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DEFINITIONS
IDA publishes the following documents to repo" the results of its work.

Reports
Reports are the most authoritative and most carefully considered products IDA publishes.
They normally embody results of major protects which (a) have a direct bearing on
decisions affecting major programs, (b) address issues of significant concern to the
Executive Branch. the Congress and/or the public, or (c) address issues that have

significant economic implications. IDA Reports are reviewed by outside panels of experts
to ensure their high quality and relevance to the problems studied, and they are released I
by the President of IOA.

Group Reports

Group Reports record the findings and results of IDA established working groups and
panels composed of senior individuals addressing major issues which otherwise would be
the subject of an IDA Report. IDA Group Reports are reviewed by the senior individuals
responsible for the project and others as selected by IDA to ensure their high quality and
relevance to the problems studied, and are released by the President of IDA.

Papers
Papers, also authoritative and carefully considered products of IDA, address studies that
are narrower In scope than those covered in Reports. IDA Papers are reviewed to ensure
that they meet the high standards expected of refereed papers in professional journals or
formal Agency reports.

Documents i
IDA Documents are used for the convenience of the sponsors or the analysts (a) to record
substantive work done in quick reaction studies, (b) to record the proceedings of
conferences and meetings, (c) to make available preliminary and tentative results of
analyses, (d) to record data developed in the course of an investigation, or (e) to forward
information that is essentially unanalyzed and unevaluated. The review of IDA Documents
is suited to their content and intended use.

[The work reported in this document was conducted under contract MDA 903 89 C 0003 for 1
the Department of Defense. The publication of this IDA document does not indicate
endorsement by the Department of Defense, nor should the contents be construed as
reflecting the official position of that Agency. I
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I
I PREFACE

I This document was prepared by the Institute for Defense Analyses (IDA) for
the Office of the Assistant Secretary of Defense (Command, Control,
Communications and Intelligence), under contract MDA 903 89 C 0003, Task Order
T-J7-832, issued 3 February 1992. The objective of this task was to derive aj methodology for estimating baseline costs of different functional areas within DoD.

This work was reviewed within IDA by Michael C. Frieders and Terri J.
SWalsh. Captain Sally Williams, one of the authors of this document, is on active

duty with the United States Air Force.

3 The model was developed in a rapid prototype process. It is undergoing
continual revision and refinement. If you need assistance or have suggestions,

Splease feel free to call or send a message:

i Telephone: (703) 845-6780

Electronic mail: feam_help@ida.orgI
I
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I I. GETTING STARTED

i This section describes how to install the model, how to enter data into the
model, and introduces the user to the model by briefly discussing how data is

I entered, analyzed, and displayed.

A. INTRODUCTION

The Functional Economic Analysis Model (FEAM) is intended to support

analyses of potential cost-saving alternatives for Department of Defense (DoD)

information management, and to aid functional managers in presenting their

"business case."' The model is designed to allow the user to enter costs and get
information for a series of alternatives to a budget baseline. The baseline
represents total current and planned DoD expenditures for a given function. A
current base representing pre-Defense Management Review (DMR) and force-
reduction levels is also presented. The model takes the user-supplied information
and performs a Risk-Adjusted, Discounted Cash Flow (RADCF) analysis for each
alternative. The results are presented in a series of graphs and tables.2

The remainder of this section gives a brief overview of how to start and use
the model. The rest of the manual consists of detailed information on the model,

including a discussion of the form of the cost data needed to run the model.

Section II guides the user through entering, editing, and analyzing the data.

Information about discount and inflation rates is presented in this section.

Section III presents the four types of computer screens that the user will
encounter. The Summary screen depicts the total costs and savings by function. The
Alternative screen depicts the savings for a particular alternative. The Cost
Breakout screen depicts costs broken out by major types of expenses. Last, the Data

Sheet screen serves as the vehicle for the user to input data into the model.

The user should consult the DoD policy on business case analysis for specific guidance on the
scope and content of a "business case."

2 This analysis is based on chapters 8 and 9 of The Business Value of Computers, Paul A.

Straussmann, New Canaan, CT: The Information Economics Press, 1990.
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Appendix A deals with the risk adjustment computation carried out by the I
model during the simulation process. An outline of cost elements used in the model

and the definitions of the cost elements are presented in Appendix B.

The following conventions are used throughout this document:

• Menu names and options are denoted in boldface (e.g., File menu)

Key strokes are denoted by < > signs (e.g., <Return> key). 3
B. INSTALLING THE MODEL

The FEAM runs on the IBM PCTM and compatibles and the Apple

MacintoshTM. The user should be familiar with pull-down menus, dialog boxes, and

use of the mouse to make selections. The model will require the following:

Minimum Recommended

Microsoft Excel 3.OTM -

A mouse ------------

2 MB of RAM 4 MB of RAM I
20 MB hard disk 40 MB or higher hard disk
2.5 MB free space 3.5 MB or more free space

--------------. Math co-processor

IBM compatibles
Microsoft Windows 3.OTM ------------

EGA display VGA or higher display
Macintosh

MultifinderTM 5
(Note: do not run FEAM under FinderTM) I

To install the model on the IBM PC and compatibles, take the following

steps: 3
1. Enter Microsoft Windows.

2. Insert the FEAM disk in drive A or B. i
3. Pull down the File menu and choose the Run... option (Figure 1). 5
4. In the command line, type "a:\setup" or "b:\setup", depending on whether

you have placed the disk in drive A or B (Figure 2). The Setup routine 3
will lead you through installation of the FEAM.

I
2 I
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I For the Apple Macintosh, take the following steps:
1. Copy the compressed version of the FEAM, labeled "FEAM Ver. 2.2a3 (Compressed)", from the FEAM disk to your hard disk.

2. Double-click on the file "FEAM Ver. 2.2a (Compressed)" on your hard3 disk. The installation program will prompt you to select a location for the

file, and then copy the model to a folder called TEAM Ver. 2.2a." Figure

3 3shows an example of the Macintosh installation screen.

1 3
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Portions of this software are copyright c 1990, Aladdin Systems, Inc. 3
Functional Economic Analysis Model (FEAM)

Developmental Version 2.2a

ShThis model is stillunder development,
and has not been

__ _ _ _ fully tested.

File: 5
Installing: I I I ,

Figure 3. Installing FEAM on the Macintosh g
Once the model is installed, make sure Excel is not already open and enter

the model by double clicking on the FEAM icon (PC compatibles) or the file 5
"bus case.xlm", and the title screen will appear, as shown in Figure 4. If you wish to
open Excel first, you may start the FEAM by choosing the "buscase~xlm" file from I
the Open option of the File menu.

tile tUelp

Functional Economic
Analysis Model

Version 2.2a

Institute for Defense Analyses
1801 N. Beauogard Street

Ajgxandni. VA 22311

choo, a Foe. to 
0

7." a Coi.
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P0Q31 S47T W i~h wl0 ks•-A # d- d D FA I S =2" "13 (1"1 Alnirnt-. I

Figure 4. Title Screen 5
i
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C. OVERVIEW OF THE MODEL

I This section briefly describes the use of the model. Figure 5 shows the entire

menu structure, which is broken into four levels. The levels are described below.

Level 1 has 10 menus available: File, Current Base, Baseline, Alt A, Alt B,

Alt C, Simulate, View, Print, and Help. The File menu allows you to open a new

case, save a case, close a case, and exit to either Excel or Windows (Desktop on the

Macintosh). When you first run the FEAM, two cases are available under Open

Case: "demo2.cim" and "initial2.cim". The case "demo2.cim" shows an example

where all the data have been filled in. The case "initial2.cim" has blank data fields

for you to fill. After filling in the data, you can choose the Save Case option to save

the case. The file name can be only eight characters long. The ".cim" extension

should not be added; this will be done by the program. Never save a file as "initial2"

or the blank data sheet will be written over.

The Current Base, Baseline, or one of the three Alternative menus lead you

through the lower levels where you can enter or view data and disaggregated graphs.

Under these menus, you may choose the Ops/Mgmt & Sup Graph option to go to

Level 2, or either the Ops Breakout option or the Mgmt & Sup Breakout option to

go directly to Level 3.

The Current Base is defined as the planned DoD expenditures for a given

function before and unaffected by DMR and force level reductions. In effect,

Current Base reflects the expected costs of doing business in the absence of DMR

and force reduction decisions. Current Base can also be viewed as the "business as

usual" or "status quo" posture. It has been incorporated into the model because it

represents a very significant point of departure for understanding the extent and

nature of cost reductions due to subsequent management initiatives to improve the

business processes.

Baseline represents total current and planned DoD expenditures for a given

function (e.g., contract payments, civilian personnel). This is after the force

reduction, and in most cases, after DMR. The Alternatives are the potential cost

savings as envisioned by the functional managers.

1 5
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B'The Simulate menu allows you to apply the RADCF procedure to any one of
the Alternatives. You can choose the Edit Parameters option, where the discountI, rate and the number of simulations can be changed. Once data have been entered
and the RADCF simulation has been run, the Summary screen shows a total cost3and savings graph. A table showing undiscounted savings by Alternative is also
available by using the View menu. The View menu allows you to toggle between

current and constant dollars and view undiscounted savings by Alternative from
both the Current Base and the Baseline. The Level 1 screen shows either the

Summary graph or one of the discounted savings tables.

The Print and Help menus are available on every level. The Print menu lets
you print the graphs or data sheets available at a particular level. The Help menu

on the first level provides help that will be useful at all levels. Help at the other

levels refers specifically to those levels.

Level 2 has two purposes: displaying the Operations/Management &
Support graph and accessing the other levels of data-entry tables. The Current Base

and Baseline graphs show total baseline costs broken out by operations and
management and support. The Alternative graphs display the differences between

total operations and total management and support costs from the Baseline over
time. The Cost Breakout menu takes you to the data-entry levels. The Return

menu allows you to return to the first level.

The Level 3 screens show a graphical display of the cost element breakout.
The Baseline cost element breakout graph represents total cost element spending
over time. The Operations breakout and Management & Support breakout screens

show the differences in cost element spending from the Baseline over time. It is at

this level that you choose a life-cycle phase for data entry. The menu choices for
data entry are RDT&E (Research, Development, Test, and Evaluation), Invest

(Investment), Op Activities (Operational Activities), Disposal, and Other. The

Subtotals menu allows you to view the cost element totals. No data are entered

under this choice. The Return menu permits you to return to Level 1 or 2.

Level 4 is where you input data. For the Current Base and Baseline, a single

entry is required. For the Alternatives, both a high and a low entry are required.
The highs and lows may be the same, or may be zero. The subtotals cost element
screen is for viewing and cannot be changed. The Return menu allows you to return

to Level 1, 2, or 3.

I7



II. MANIPULATING DATA

This section explains how to enter and edit data, and how to analyze the

results.

A. ENTERING DATA

The steps for data entry are summarized below.

From the title screen of the model, pull down the File menu and select

the Open Case option.

Double-click on the file "initial2.cim". A message will appear that

suggests first-time users choose the Baseline menu item.

Pull down the Baseline menu and select the Ops Breakout option. This

allows you to bypass the Alternative graph level (Level 2) and go

directly to Level 3, where the life-cycle phase is chosen.

Pull down the RDT&E menu item and select the Data Sheet option.

This brings you to Level 4 where all cost data are entered.

Enter the cost data for the RDT&E phase. All cells must contain a

number, even if that number is zero. For the Alternatives, the "high"

and low" may be the same.

* Pull down the Return menu and select the Breakout option to get back

to the life-cycle phase position.

I Choose another life-cycle phase and enter data as for RDT&E. Repeat
for each life-cycle phase.

* Choose the Summary option from the Return menu. This will take you

back to Level 1.

I Pull down the Baseline menu and select the Mgmt & Sup Breakout

option and repeat the steps for entering data for each life-cycle phase.

I After all data for the Baseline have been entered, pull down the Return

menu and select the Summary option.

I
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Select an Alternative (A, B, or C) ard enter data as for the Baseline. I
Room is provided for three Alternatives, although only one is needed to

run a simulation. If you need more than three Alternatives, create a I
new case. If you plan to run many Alternatives on the same Baseline

data, make a template after entering your Baseline data, and before 3
entering the Alternative data. To do this, enter the Baseline data only,

and save the file under a different name (e.g., "basel"). When you open 3
a case, bring up your template instead of "initial2.cim".

When all the data are entered, pull down the Return menu and select 3
the Summary option. You may now run the simulation by choosing one

of the options under the Simulate menu. 3
To save your work, pull down the File menu and select the Save Case

option. Enter a file name with no more than 8 characters. Do not enter

an extension; the extension ".cim" will be automatically attached. All

data for the Baseline and up to three Alternatives can be entered into

one file.

B. EDITING DATA 3
Once you are in a data sheet, use the arrow keys or the mouse to move the

cross hairs to the position to be edited. A rectangular box will appear at the U
position to be edited. Type in the desired value and press the <Return> key. All

values are in millions of current-year dollars. Below are definitions for the high and 3
low values and what to do when the cost is known with certainty.

* High - The high estimate represents the cost that is exceeded by the I
actual cost only 2.5 times out of 100.

Low - The low estimate represents the cost that exceeds the actual cost 3
only 2.5 times out of 100.

Certainty - If you know with certainty the cost, then make the high and I
low values the same.

For the simulation to execute correctly, all cells must contain a non-negative I
numeric value. Do not run the simulation with blank cells; enter zeroes where

appropriate. 3
I

10 3



C. ANALYZING DATA

Once you have entered the data, the model can analyze the data using the

Risk-Adjusted, Discounted Cash Flow (RADCF) analysis. The results are shown as
graphs and a table. To implement the analysis, choose one of the options under the

Simulate menu at the top level. Each Alternative must be simulated separately.

The simulation process takes between 50 seconds and 20 minutes on a computer

with a math co-processor. Without the math co-processor, it will take much longer.

Changes to the discount rate and the number of simulations can be made by

selecting the Edit Parameters option from the Simulate menu. For final analysis,

500 simulations are recommended; however, 100 simulations can be used for an

intermediate analysis. Running time for 100 simulations is significantly shorter than

for 500 simulations.

After selecting the Alternative to simulate, you will be asked for the residual

value, the expected useful life of the Alternative beyond the six-year planning period

incorporated into the model. To calculate the residual, the model takes the net

savings for the last year of the planning period (year 6) and computes the present
value of the stream for the selected number of additional years.

The RADCF calculation uses the "high" and "low" estimates entered under

the Alternatives to generate a distribution of possible values for each cost element.

The model then estimates the cost for each year in each cost category based on a
value from that distribution, subtracts it from the corresponding Baseline, and sums

all those values to generate a total savings estimate. This process is repeated 500
times. The model then reports the average of these estimates to give an expected

savings, as well as a "best" and "worst" case to give a feel for the distribution of these

savings. A complete discussion of the simulation methodology is presented in

Appendix A.

1 11
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The graphs can be viewed in either current or constant dollars. Four I
different deflators are used for converting "then" or current-year dollars into

constant-year dollars for the eight cost elements as follows:

Cost Element Deflator
Civilian labor TOA-Civilian pay 3
Military labor TOA-Total Pay and Allowances
Information Technology Provided by DDI
Facilities TOA-Total Non-pay I
Material TOA-Total Non-pay
Other TOA-Total Non-pay
General Installation Support TOA-Total Non-pay
Headquarters Support TOA-Total Non-pay

The Total Obligational Authority (TOA) deflators are taken from Table 5-5

of the National Defense Budget Estimates for FY 1992 prepared by the DoD U

Comptroller. The Director of DoD Information (DDI) has elected to provide a

separate rate for the Information Technology category because of its unique 3
declining cost behavior in recent years. The deflators are as follows:

Cost Element 1992 1993 1994 1995 1996 1997 3
Total Non-pay 1.0000 1.0357 1.0721 1.1089 1.1468 1.1860
Information Technology 1.0000 0.8800 0.7740 0.6810 0.6000 0.5280 m
Civilian Labor 1.0000 1.0459 1.0908 1.1356 1.1810 1.2282
Total Pay and Allowances 1.0000 1.0449 1.0892 1.1333 1.1784 1.2250 £

The expected RADCF appears on the Summary and Alternative graphs. The

"best" and "worst" case RADCFs are shown on the Summary graph. Undiscounted I
savings are available under the View menu at Level 1.

The results may be printed as graphs or tables. A Print menu is found at

each level, and can be used to print only those tables and graphs displayed at that

level. 3

I
12!
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III. THE SCREENS

This section provides a summary of the main screens and their functions. All

the graphs require that the data for the Current Baseline, Baseline, and at least one

Alternative be filled in.

A. LEVEL 1 - THE SUMMARY SCREEN

The Summary screen is viewed from Level 1 and is shown in Figure 6. If you

are at a different level, Level 1 can be reached by choosing the Summary option

from the Return menu.

- Ell1_e Cyrrnt Base Baseline AIIA A1112 Alt.C Simulate Ifiew E~rInt Hjelp

Summary of Functional Area
Total Cost and Savings

400

p2W

0III I!1100

Ya I Yew 2 Y'1113 Ys 4 Y0115 Yew 6

RADCF (AI A) RADCF (AA B) RADCF (AlM C)
High 1216 High 1158 High ills
Evpe.-d $196 vec.-,d 1135 E sd'd $96
LoM $174 LOW slog L" 179

Figure 6. The Summary Screen

The Summary screen shows the total undiscounted costs associated with the

Current Baseline, Baseline, and each Alternative. There is a Summary screen for

current-year dollars and a Summary screen for constant-year dollars. You may

toggle between these screens using the options in the View menu. At the bottom of
each screen, three RADCF values for each Alternative are displayed. The RADCF

represents the cumulative present value of cost savings of each Alternative. The

expected RADCF is the average RADCF created by the simulation process, which

13
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incorporates risk into the RADCF values. The high and low RADCFs represent the !
"best" and "worst" cases, respectively. For more information on the risk adjustment

calculation, see Appendix A.

The menu choices at the Summary screen include Current Base, Baseline,

and the three Alternatives, which take you to the Operations/Management & i
Support breakout (Level 2) or the Cost Element breakout (Level 3). Also from this

screen, you may open and save files, print the Summary graph and undiscounted 3
savings tables for both Current Base and Baseline, invoke the simulation routine for

a particular Alternative, and exit the model. Help at this level includes information 3
on commands, cost structure, and cost element descriptions, as well as information

about the Summary screen.

There are three options under the pull-down menus for Current Base,

Baseline, and each Alternative, as shown in Figure 7. The first option, Ops/Mgmt

& Sup Graph, allows you to display the Baseline total costs, broken out by total

operations costs and total management and support costs. When this option is

selected from one of the Alternative menus (Alt A, Alt B, or Alt C), the cost savings
are displayed for the selected Alternative, broken out by operations and
management and support costs. These savings represent the differences from the 1
Baseline. U

- i. Ba.eline A•A AIID Alt S ilmuiate Diew ,Ilnt btlp i

ý opsNASugmt 
a Sup grAeph

do., Sup Breakou mazy of Functional AreaI
Total Cosa and Savings

RADCF (AN A) PkADCF (Alt 8) RADCF (At C)
SHigh 5216 High 51-8 High $115

Expe~md $196 Expeced 9135 Epectad 596
LOW $1 74 LOW slog9 LOW on•

Figure 7. Choosing a Breakout Screen I

I
14 1



I

I The second option, Ops Breakout, displays total operations costs for the

Current Base or Baseline broken out by major types of expenses, or, in the case of

the Alternatives, the cost savings for operations by major types of expenses.

The third option, Mgmt & Sup Breakout, mirrors the Ops Breakout option

for the management and support side. From the breakout selections, you can access

the data sheets on Level 4.I
B. LEVEL 2 - THE OPERATIONS/MANAGEMENT AND SUPPORT SCREEN

The Level 2 screen displays total undiscounted baseline costs by operations
and management and support, or total undiscounted alternative savings by the same3 categories. A ratio of operations to management and support is also shown as the
tooth-to-tail ratio, and is read off the right axis. By selecting the Ops/Mgmt & Sup

I Graph option from the Baseline menu, a graph similar to Figure 8 is displayed.

3 -" eturn Cost Breakout L.)inl Help

Baseline
Total Operations

__ Total Manaement a Support

I250 . 41,0%

I I I I
Yost1 Ye.r2 Y. 5 3 Y.w4 Ya 5 Yww

Figure 8. Baseline Ops/Mgmt & Sup Graph

- At this point you can return to the Summary graph by choosing the ReturnI menu and Summary option or break out the costs in more detail.

If instead you select one of the Alternative menus and the Ops/Mgmt & SupI Graph option, a graph similar to the one in Figure 9 is displayed. The tooth-to-tail
ratio is also displayed on the Alternative screen. The expected RADCF is displayed

at the bottom of the screen.

15



I l

"I Beturn fost Breakout ELint tielp

Alternative A Cost Savings
Deltas from Baseline

I 30 11

37.W% c

.:1 P1!

R~iC.1200

2.

34.W2

4SD 3410 W
'I Ft Yew? Ye.3 yew4 yeas Yeas,

R.ADCF 12401

Figure 9. Alternative Screen

At this point you can return to the Summary graph by choosing the Return

menu item and the Summary option or break out the cost savings further. 3
C. LEVEL 3 - THE COST BREAKOUT SCREEN

If you are following the Current Base or Baseline path and select the i
Operations option from the Cost Breakout menu, a graph similar to Figure 10 is
displayed. This graph depicts total operations costs broken out by six cost elements: I

Civilian Labor, Military Labor, Information Technology, Facilities, Materiel, and
Other. If you select the Management & Support option from the Cost Breakout 5
menu, these six cost element categories plus General Installation Support and
Headquarters Support costs are broken out. 5

From this level, you can return to the previous levels by using the Return

menu, or you can select a life-cycle phase and examine or enter the actual cost data 5
in the data sheets. You can also examine the total cost data by selecting the
Subtotals menu. The values in the subtotal sheet are for viewing only and cannot be

changed.

1I
I
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3 Figure 10. Cost Breakout Screen

If you are following an Alternative path and select the Cost Breakout menuI item and the Operations option, a graph similar to Figure 11 is displayed. T'his
screen depicts operations cost savings broken out by the cost elements. Similarly, if3 you select the Management & Support option, the management and support cost
savings are broken out.

3-1 Belurm jubtatels RDI&E Invest 0 Aolivies Dlisposal 2tlter Erlnt tielp

Operations Cost Savings Breakout
.hermathvg C - Oelas" tran Baselims

50t --

-2110

'ise Y*02 YOM3 yew 4 YOU5 Yeas

3 Figure 11. Alternative Breakout Screen
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From this screen, you can return to the previous screens by using the Return I
menu, or you can select a life-cycle phase and examine or enter the actual cost data

in the data sheets. Again, you can examine the total cost data by cost element by 1
selecting the Subtotals menu.

D. LEVEL 4 - THE DATA SHEET SCREEN I
Level 4 is where you enter data. The first data sheet, shown in Figure 12, is

for the Baseline RDT&E costs. The second data sheet, shown in Figure 13, is for

RDT&E costs for an Alternative. The only difference between these screens is that

high and low values are entered for an Alternative. The values that make up the

Baseline and each Alternative are entered in the data sheets. Each cell must have a

numeric value in it, even if that value is zero. The high and low entries may have

the same value. All data should be rounded to two decimal places. Once the values
are entered, the Alternatives can be processed by the simulation routine from the 3
Summary screen.

Z- Beturn prnt tjslp irotExe-TMPXSU131'

A. Baseline Operations Cost Data Sheets
Al RDTAIE PhaseI

(Millions Of Curent Yeaw Dollars)
Year 1 Year 2 Year 3 Year 4 Year 5 Yeaw 6

A1.1 Covian Labor 27--2- - -

AlI MillOeryILabor Lc 1.0O _S. 96. _4 __0
2  

- O.9OI

A1.3 Information Technology Fr 2 0oo 1 94! 1.887 71.831 1.77! 1.72:

Al4•.Fa,, i To, o.go T o5P ,-"--"if 7-o. '•'qT

AIA elerel 4SOT___ f_____ ___4 1

Al. 6Other 4.0_ . 3.92! 384! 3.76! 316 3.62 I
I

Figure 12. Baseline Data Sheet Screen

The Help menu at the Data Sheet level includes information on the cost

element structure and cost element definitions. 5
I
U
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A. Operations Cott Data Sheets, Alternative A
At RDT&E Phase

IMlions of Current Year Dollers)
Year1 Year 2 Year3 Yew 4 Year 5 Yea 6

Al 1 Civilen Labor High -- 7-- ----2 -4 3 --- 2Ti igT7-- 7- -1.77
Low 1 300 2.55! 2.17'- 1.84 1.57i 1.33

At .2 MiItay Labor High 1.00 0.90, 01 0.73i 0.66: 09
1.00: 0.8 072, 061 052. 0.44

A1.3 Informaiton Technology High rF 2.001 1.801 1.621 1,461 1.31 1.18
LW 2.00 1.701 1.451 1.231 1.041 o.es

A1 4Faclities High 090 081-073 066 0.59
Low _1 1.00; 0. 7 0-1 ! 0,52 0.44

A1.5Mteriel High =5K00i- 4.50i 405i 3.65i 3.28! 2.95
L- ._.__00j 4.26 3.61_ 61 2.22

A.I Other High I 4_00! 360! 3.24! 292! 2.62! 2.36r 4.00' 3.4--'0-" 2.46 2.09. 1.77

Figure 13. Alternative Data Sheet Screen
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I APPENDIX AI RISK ADJUSTMENT CALCULATION

In order to explicitly account for the risks of any given Alternative, a

simulation routine has been incorporated into the model. The simulation is
performed by selecting the Simulate menu at Level 1 and choosing one of the

I Alternatives (Alt A, Alt B, or Alt C).

The simulation routine works in the following manner:

Each cost element is specified under the Baseline (B) and under the

Alternative (A). If the cost is incurred in year t, the discounted cost saving is
] B-A

NPV = where r is the discount rate. Note that we adopt an "end-of-year"
(1l+r)'

discounting convention, so that even savings that accrue in the first year (currently
FY 1992) are discounted. The savings are summed over all cost elements and all1 years. An example is shown below, with a discount rate of 10 percent.

Year I Year 2 Year3
Baseline 200 180 160

Alternative 190 150 110I
NPV= B"-AI B2 -A 2  B3 -A 3

(1 +ry (I1+r)2 (+r)3

I 10 30 50
NPV = +- +

110 L21 133

NPV = 7L5

By default, the model employs a real discount rate of 10 percent per year
(0.10). However, the user may alter this parameter by choosing the Edit Parameters
option from the Simulate menu at Level 1. Be certain to enter the discount rate as

a decimal (Figure A-i).

I
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Eile Current Base Baseline Alt A ALt B Alt f Simulate Yiew Print Help

Summary of Functional Area
Total Cost and Savings

400

30Edil Paiwasteas=-.-.. O uk

2M Nb. ol Sudam AaN A

AA

X 3I

Ye I1 Ya 2 You 3 Yea 4 Ye 5 Yas 6

PADCF (At A) PADCF (At B) RADCF (Alt CQ

High $216 High $158 High $115
Expected $196 Expected $135 Expected $96
Low $174 Low $109 Low $79

Figure A-1. Edit Parameters

Ordinarily, cost elements are tracked for six years. However, the user has the 5
option of specifying a "residual value." Under this cution, ali costs for the sixth year

are repeated for as many additional years as the user specifies (up to 20 additional 3
years), as illustrated below for a residual value of 2.

B1 -A1  B2 -A 2  B3 -A 3  B4 -A 4  B5 -A 5  B6 -A 6 +B6 - A6 + B6 -A 6  I
(1V • +- (1 + r.+--- 1(+r)3(1 +. r+4- Q ++r)5 (1+ +r)6 (1+r)7 (1+r)8

The cost elements under the Alternative are simulated to reflect risk. In the

data screens, each cost element is entered as both a "low" value (L) and a "high" 3
value (H). These values are chosen so that a cost below L occurs only 2.5 percent of

the time, and similarly for a cost above H. I
The Alternative cost elements are simulated from a lognormal distribution.

That is, the natural logarithm of cost is assumed to have a normal distribution. The 3
lognormal distribution, which applies to the cost element itself, has the property of

being skewed to the right, so that extreme costs due to programming errors,

schedule delays, etc., are accommodated.

On the logarithmic scale, the mean (denoted m) of the normal distribution is 3
(iogH +iogL)

estimated as the midpoint of the logs of the high and low values, m g

A-2 I



I We also use the fact that 95 percent of a normal distribution lies within ±2 standard

deviations (denoted s) of the mean. Hence logH - logL=4s, or s - (logH4 log)

and the variance v=s 2. On the logarithmic scale, the low and high cost inputs may

I be interpreted as a band lying ±2 standard deviations from the "best guess."

By default, the Alternative is simulated 100 times. Within each simulation,

every cost element is drawn from its respective lognormal distribution. Then the

discounted sums of savings from the Baseline are computed. The result is 1003 discounted sums. By choosing Edit Parameters under the Simulate menu, the use

may alter the number of simulations to any number between 1 and 500. We do notI recommend that the number be reduced below 100. We recommend that 100
simulations be performed during the early, exploratory stages of analysis. However,

100 simulations may still embody considerable statistical "noise." Therefore, we

recommend that 500 simulations be performed for the final analysis.

The output screens report the mean of the 100 (or more) simulations. To

reflect the risk of an Alternative, we also report the 2.5 and 97.5 percentiles from

the distribution of cost differences. The 2.5 percentile is the value that lies above

only 2.5 percent of the simulated cost differences. This value represents the "worst
case." The 97.5 percentile is the value that lies above 97.5 percent of the simulated

cost differences, or below only 2.5 percent of them. This value represents the "best

case."
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I APPENDIX B

COST STRUCTURE OUTLINE AND DEFINITIONS

For the results of the model to be useful, the cost data must be entered in a

consistent fashion across all functional areas. This involves using a cost breakdown

structure that incorporates the major phases and expense types that are important to3 life cycle costing. The first subsection of the appendix shows an outline of the cost

structure. The second subsection lists detailed definitions for each cost element.

COST STRUCTURE

3 The cost structure includes three levels of indenture. Each item at the third

level should be entered by year, and by high and low estimate where appropriate.

Functional managers may choose to maintain these data in a less aggregated form

for their own purposes.

A. Operations Costs

Al. RDT&E Phase
A1.1 Civilian Labor
A1.2 Military Labor
A1.3 Information Technology
A1.4 Facilities
A1.5 Materiel
A1.6 Other

A2. Investment Phase
A2.1 Civilian Labor
A2.2 Military Labor

A2.3 Information Technology
A2.4 Facilities

-- A2.5 Materiel
A2.6 Other

I
1
I
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A3. Operational Activities
A3.1 Civilian Labor
A3.2 Military Labor
A3.3 Information Technology
A3.4 Facilities
A3.5 Materiel
A3.6 Other

A4. Disposal
A4.1 Civilian Labor
A4.2 Military Labor
A4.3 Information Technology 3
A4.4 Facilities
A4.5 Materiel
A4.6 Other

A5. Other Unique Phases (as required)
A5.1 Civilian Labor l
A5.2 Military Labor
A5.3 Information Technology
A5.4 Facilities
A5.5 Materiel
A5.6 Other I

B. Management & Support Costs

B1. RDT&E Phase
BI.1 Civilian Labor
B1.2 Military Labor 3
B1.3 Information Technology
B1.4 Facilities
B1.5 Materiel
B1.6 Other
B1.7 General Installation Support (General and

Administrative)
B1.8 Headquarters Support

I
I
I

B-2



I

B2. Investment Phase
B2.1 Civilian Labor
B2.2 Military Labor
B2.3 Information Technology
B2.4 Facilities
B2.5 Materiel
B2.6 Other3 B2.7 General Installation Support (General and

Administrative)
B2.8 Headquarters Support3 B3. Operational Activities Phase
B3.1 Civilian Labor3 B3.2 Military Labor
B3.3 Information Technology
B3.4 Facilities

i B3.5 Materiel
B3.6 Other
B3.7 General Installation Support (General and

Administrative)
B3.8 Headquarters Support

i_ B4. Disposal Phase
B4.1 Civilian Labor3 B4.2 Military Labor
B4.3 Information Technology
B4.4 Facilities3 B4.5 Materiel
B4.6 Other
B4.7 General Installation Support (General and

Administrative)
B4.8 Headquarters Support

3 B5. Other Unique Phases (as required)
B5.1 Civilian Labor
B5.2 Military Labor
B5.3 Information Technology
B5.4 Facilities
B5.5 Materiel
B5.6 Other
B5.7 General Installation Support (General and

Administrative)
B5.8 Headquarters Support
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COST DEFINITIONS

This section provides cost definitions for the cost structure shown in section 3
A. The taxonomy is summarized here in the Coding Structure sub-section, and
further explanation is provided in the Coding Detail sub-section. I
1. Coding Structure 3

The first three levels of this structure are required by the model, further
detail may be of value to the functional areas. 5

Position 1: Primary Subdivision of Costs

A (Operations Costs) or B (Management and Support) refers largely to the 3
distinction between direct (Operations) and indirect (Management & Support)
costs. I

Position 2: Phase of Work

1 (RDT&E), 2 (Investment), 3 (Operational Activities), 4 (Disposal), 5 5
(Other). The phases represent a summary description of the general kinds of
activities being performed to produce output. The costs of each phase can be 5
funded by several different appropriations.

Position 3: Major Cost Elements 3
Identifies the major types or kinds of resources being used to produce output

by Operations and Management & Support as follows: 3
Operations Costs: 1 (Civilian Labor), 2 (Military Labor), 3 (Information

Technology), 4 (Facilities), 5 (Materiel), 6 (Other); U
Management & Support Costs: 1 (Civilian Labor), 2 (Military Labor), 3

(Information Technology), 4 (Facilities), 5 Materiel), 6 (Other), 7 (General U
Installation Support - General and Administrative), 8 (Headquarter's

Support of Installations).

Positions 4-6: Breakout of Major Cost Elements

Breakout is provided by category and source of funding (appropriations and U
program elements).

I



2. Coding Detail

A. Operations Costs. Represents costs of essential functional activities that
are directly related to the primary output(s) of an organizational unit for its
intended customers.

Al. Research, Development, Test and Evaluation (RDT&E) Phase.
Includes all direct costs involved in research, development, test and
evaluation of a new system or a major modification for eventual production
and use in operational activities.

A1.1 Civilian labor. Includes the total civilian pay cost, both
gross pay and all personnel benefits (e.g., retirement, health
insurance, etc.) for all personnel directly involved ("hands on") in
producing the primary outputs of an organization. These costs
exclude all personnel costs for supervision and management.

3 A1.2 Military labor. Includes the total of all officer and
enlisted pay, including allowances and retirement, for all personnel
directly involved ("hands on") in producing the primary outputs of an
organization. These costs exclude all personnel costs for supervision
and management.

3 AU.3 Information technology. Represents the cost of hardware
(including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources
that can be specifically and directly identified to a primary output.
The costs of assets already purchased will only be included when they
are already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation and amortization are
excluded.

Al.4 Facilities. Consists of all costs involved in owning,
leasing and operating a facility that can be directly and solely3 identified to a specific primary output. It would include costs for
construction (including modification) if purchr 3ed, leasing costs if
rented, appropriate utility charges, and repair and maintenance
services (including land-related). The costs of assets already
purchased will only be included when they are already being used or
are planned to be sold or used on another project. Non-cash charges
such as depreciation are excluded.

Al.5 Materiel. Includes all costs for purchases of office
furniture, equipment (non-computer), supplies, including printing, and
postage that can be directly identified to a primary output. The costs3 of assets already purchased will only be included when they are
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already being used or are planned to be sold or used on another !
project. Non-cash charges such as depreciation are excluded.

A1.6 Other. All other costs that can be specifically identified
to a primary output such as project travel, specific job-related
technical training, and transportation costs that are not covered by any
of the other elements. All non-cash charges such as depreciation and I
amortization are excluded.

A2. Investment Phase. Includes all direct costs associated with the 3
initial and new purchase of capital assets (real property and equipment) and
non-recurring installation and start-up costs. The costs of assets already
purchased will only be included when they are already being used or are I
planned to be sold or used on another project.

A2.1 Civilian labor. Includes the total civilian pay cost, both 3
gross pay and all personnel benefits (e.g., retirement, health
insurance, etc.) for all personnel directly involved ("hands on") in
producing the primary outputs of an organization. These costs I
exclude all personnel costs for supervision and management.

A2.2 Military labor. Includes the total of all officer and i
enlisted pay, including allowances and retirement, for all personnel
directly involved ("hands on") in producing the primary outputs of an
organization. These costs exclude all personnel costs for supervision
and management.

A2.3 Information technology. Represents the cost of hardware I
(including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources
that can be specifically and directly identified to a primary output.
The costs of assets already purchased will only be included when they
are already being used or are planned to be sold or used on another a

project. Non-cash charges such as depreciation and amortization are
excluded. 3

A2.4 Facilities. Consists of all costs involved in owning,
leasing, and operating a facility that can be directly and solely
identified to a specific primary output. It would include costs forI
construction (including modification) if purchased, leasing costs if
rented, appropriate utility charges, and repair and maintenance
services (including land-related). The costs of assets already U
purchased will only be included when they are already being used or
are planned to be sold or used on another project. Non-cash charges
such as depreciation are excluded.

I
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A2.5 Materiel. Includes all costs for purchases of office
furniture, equipment (non-computer), supplies, including printing, and
postage that can be directly identified to a primary output. The costs
of assets already purchased will only be included when they are
already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation are excluded.

A2.6 Other. All other costs that can be specifically identified
to a primary output such as project travel, specific job-related
tec' -cal training, and transportation costs that are not covered by any
of the other elements. All non-cash charges such as depreciation and
amortization are excluded.

A3. Operational Activities Phase. Represents the recurring costs that
can be directly identified to routinely producing primary functional outputs.

A3.1 Civilian Labor. Includes the total civilian pay cost, both
gross pay and all personnel benefits (e.g., retirement, health
insurance, etc.) for all personnel directly involved ("hands on") in
producing the primary outputs of an organization. These costs
exclude all personnel costs for supervision and management.

A3.2 Military Labor. Includes the total of all officer and
enlisted pay, including allowances and retirement, for all personnel
directly involved ("hands on") in producing the primary outputs of an
organization. These costs exclude all personnel costs for supervision
and management.

A3.3 Information Technology. Represents the cost of
hardware (including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources
that can be specifically and directly identified to a primary output.
This includes all maintenance and repair, minor modifications, and all
replacement items (excluding initial purchase). The costs of assets
already purchased will only be included when they are already beingI used or are planned to be sold or used on another project. Non-cash
charges such as depreciation and amortization are excluded.

A3.4 Facilities. Consists of all costs involved in owning,
leasing and operating a facility that can be directly and solely
identified to a specific primary output. It would include costs for

m- construction (including modification) if purchased, leasing costs if
rented, appropriate utility charges, and repair and maintenance3 services (including land-related). The costs of assets already
purchased will only be included when they are already being used or

I
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are planned to be sold or used on another project. Non-cash charges I
such as depreciation are excluded.

A3.5 Materiel. Includes all costs for purchases of office
furniture, equipment (non-computer), supplies, including printing, and
postage that can be directly identified to a primary output. The costs
of assets already purchased will only be included when they are I
already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation are excluded. 3

A.3.6 Other. All other costs that can be specifically identified
to a primary output such as project travel, specific job-related
technical training, and transportation costs that are not covered by any U
of the other elements. All non-cash charges such as depreciation and
amortization are excluded. 3
A4. Disposal Phase. Represents the direct costs of disposing assets

less the estimated salvage value or sales price.

A4.1 Civiliin labor. Includes the total civilian pay cost, both
gross pay ..-!, all personnel benefits (e.g., retirement, health
insuranc. .tc.) for all personnel directly involved ("hands on") in I
producing the primary outputs of an organization. These costs
exc!ude all personnel costs for supervision and management. 3

A4.2 Military labor. Includes the total of all officer and
enlisted pay, including allowances and retirement, for all personnel
directly involved ("hands on") in producing the primary outputs of an U
organization. These costs exclude all personnel costs for supervision
and management. 3

A4.3 Information Technology. Represents the cost of
hardware (including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources I
that can be specifically and directly identified to a primary output.
The costs of assets already purchased will only be included when they 3
are already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation and amortization are
excluded.

A4.4 Facilities. Consists of all costs involved in owning,
leasing and operating a facility that can be directly and solely 3
identified to a specific primary output. It would include costs for
construction (including modification) if purchased, leasing costs if
rented, appropriate utility charges, and repair and maintenance l
services (including land-related). The costs of assets already

I
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purchased will only be included when they are already being used or
are planned to be sold or used on another project. Non-cash charges
such as depreciation are excluded.

A4.5 Materiel. Includes all costs for purchases of office
furniture, equipment (non-computer), supplies, including printing, and
postage that can be directly identified to a primary output. The costs
of assets already purchased will only be included when they are
already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation are excluded.

A4.6 Other. All other direct costs that can be specifically
identified to a primary output such as project travel, specific job-
related technical training, and transportation costs that are not
covered by any of the other elements. All non-cash charges such as
depreciation and amortization are excluded.

A5. Other Unique Phases (as required). Reserved for special or
unique types of activities that do not generally fit any of the other phases and
is of such significance to warrant separate accounting.

B. Management & Support Costs. Consists of all costs other than
operational costs. Such costs are considered to be indirectly related to the primary
output because they cannot be easily or economically identified to an output and3 typically support more than one primary output.

B1. Research, Development, Test and Evaluation (RDT&E) Phase.
Includes all indirect costs involved in research, development, test and
evaluation of a new system or a major modification for eventual production
and use in operational activities.

B1.1 Civilian labor. Consists of the total civilian pay costs,
both gross pay and benefits, for all management, supervision and
administration for the functional unit. Represents supervision and
management within the functional unit and the cost of all
administrative activities (e.g., secretarial, general administration, etc.).
Also includes the indirect costs for all activities performed within the
basic organization (which the functional unit is a part of) at all levels
(both installation and headquarters) to support the primary outputs of
the particular functional unit.

B1.2 Military labor. Consists of the pay, including allowances
and retirement, for all management, supervision and administration
for the functional unit. Represents supervision and management
within the functional unit and the cost of all administrative activities
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(e.g., secretarial, general administration, etc.). Also includes the I
indirect costs for all activities performed within the basic organization
(which the functional unit is a part of) at all levels (both installation
and headquarters) to support the primary outputs of the particular
functional unit.

B1.3 Information Technology. Represents the cost of
hardware (including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources
that cannot be specifically and directly identified to a primary output.
Such costs are incurred within the functional unit or the basic
organization (which the functional unit is a part of) at all levels (both
installation and headquarters). Normally these resources support two
or more primary outputs and cannot be traced easily or economically
to primary outputs. The costs of assets already purchased will only be
included when they are already being used or are planned to be sold
or used on another project. Non-cash charges such as depreciation 3
and amortization are excluded.

B1.4 Facilities. Consists of all indirect costs involved in
owning, leasing and operating a facility that cannot be directly and
solely identified to a specific primary output. Such costs are incurred
within the functional unit or the basic organization (which the 3
functional unit is a part of) at all levels (both installation and
headquarters). Normally these resources support two or more
primary outputs and cannot be traced easily or economically to I
primary outputs. It would include costs for construction (including
modification) if purchased, leasing costs if rented, appropriate utility
charges, and repair and maintenance services (including land-related).
The costs of assets already purchased will only be included when they
are already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation are excluded.

B1.5 Materiel. Includes all indirect costs for purchases of
office furniture, equipment (non-computer), supplies including,
printing, and postage that cannot be directly identified to a primary
output. Such costs are incurred within the functional unit or the basic 3
organization (which the functional unit is a part of) at all levels (both
installation and headquarters). Normally these resources support two
or more primary outputs and cannot be traced easily or economically I
to primary outputs. The costs of assets already purchased will only be
included when they are already being used or are planned to be sold
or used on another project. Non-cash charges such as depreciation
are excluded.
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I B1.6 Other. Includes all indirect costs other than labor which
support primary outputs such as general training, transpertation, and

I travel. Such costs are incurred within the functional unit or the basic
organization at all levels (both installation and headquarters) and
cannot be readily classified within any of the other five cost elements.
Non-cash charges such as depreciation are excluded.

B1.7 General Installation Support (General and
I Administrative). Includes all indirect costs for activities performed by

installation organizations (other than the basic organization of the
functional unit) in support of the functional unit. It includes all the
major cost elements excluding information technology i.e. labor,
facilities, materiel, and other. Non-cash charges such as depreciation
and amortization are excluded.

B1.8 Headquarters Support of Installations. Represents the
indirect costs of major and intermediate commands, Service
headquarters, Office of Secretary of Defense, Joint Chiefs of Staff,
other Defense agencies, and functional headquarters at both the
Service and OSD levels.

B2. Investment Phase. Includes all indirect costs associated with the
initial and new purchase of capital assets (real property and equipment) and
non-recurring installation and start-up costs. The costs of assets already
purchased will only be included when they are already being used or areI planned to be sold or used on another project.

B2.1 Civilian labor. Consists of the total civilian pay costs,
both gross pay and benefits, for all management, supervision and
administration for the functional unit. Represents supervision and
management within the functional unit and the cost of all

Sadministrative activities (e.g., secretarial, general administration, etc.).
Also includes the indirect costs for all activities performed within the
basic organization (which the functional unit is a part of) at all levels
(both installation and headquarters) to support the primary outputs of
the particular functional unit.

I B2.2 Military labor. Consists of the pay, including allowances
and retirement, for all management, supervision and administration
for the functional unit. Represents supervision and management
within the functional unit and the cost of all administrative activities
(e.g., secretarial, general administration, etc.). Also includes the
indirect costs for all activities performed within the basic organization

(which the functional unit is a part of) at all levels (both installation

I
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and headquarters) to support the primary outputs of the particular I
functional unit.

B2.3 Information Technology. Represents the cost of
hardware (including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources
that cannot be specifically and directly identified to a primary output. I
Such costs are incurred within the functional unit or the basic
organization (which the functional unit is a part of) at all levels (both
installation and headquarters). Normally these resources support two
or more primary outputs and cannot be traced easily or economically
to primary outputs. The costs of assets already purchased will only be 5
included when they are already being used or are planned to be sold
or used on another project. Non-cash charges such as depreciation
and amortization are excluded.

B2.4 Facilities. Consists of all indirect costs involved in
owning, leasing and operating a facility that cannot be directly and
solely identified to a specific primary output. Such costs are incurred
within the functional unit or the basic organization (which the

functional unit is a part of) at all levels (both installation and I
headquarters). Normally these resources support two or more
primary outputs and cannot be traced easily or economically to 1
primary outputs. It would include costs for construction (including
modification) if purchased, leasing costs if rented, appropriate utility
charges, and repair and maintenance services (including land-related).
The costs of assets already purchased will only be included when they
are already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation are excluded.

B2.5 Materiel. Includes all indirect costs for purchases of
office furniture, equipment (non-computer), supplies including, I
printing, and postage that cannot be directly identified to a primary
output. Such costs are incurred within the functional unit or the basic
organization (which the functional unit is a part of) at all levels (both
installation and headquarters). Normally these resources support two
or more primary outputs and cannot be traced easily or economically
to primary outputs. The costs of assets already purchased will only be
included when they are already being used or are planned to be sold
or used on another project. Non-cash charges such as depreciation U
are excluded.

B2.6 Other. Includes all indirect costs other than labor which 3
support primary outputs such as general training, transportation, and
travel. Such costs are incurred within the functional unit or the basic 5
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organization at all levels (both installation and headquarters) and
cannot be readily classified within any of the other five cost elements.
Non-cash charges such as depreciation are excluded.

B2.7 General Installation Support (General and
Administrative). Includes all indirect costs for activities performed by
installation organizations (other than the basic organization of the
functional unit) in support of the functional unit. It includes all the
major cost elements excluding information technology i.e. labor,
facilities, materiel, and other. Non-cash charges such as depreciation
and amortization are excluded.

B2.8 Headquarters Support of Installations. Represents the
indirect costs of major and intermediate commands, Service

I headquarters, Office of Secretary of Defense, Joint Chiefs of Staff,
other Defense agencies, and functional headquarters at both the
Service and OSD levels.

B3. Operational Activities. Represents the recurring indirect costs
that can be directly identified to routinely producing primary functional3 outputs.

B3.1 Civilian labor. Consists of the total civilian pay costs,
both gross pay and benefits, for all management, supervision and
administration for the functional unit. Represents supervision and
management within the functional unit and the cost of all
administrative activities (e.g., secretarial, general administration, etc.).
Also includes the indirect costs for all activities performed within the
basic organization (which the functional unit is a part of) at all levels
(both installation and headquarters) to support the primary outputs of
the particular functional unit.

I B3.2 Military labor. Consists of the pay, including allowances
and retirement, for all management, supervision and administration
for the functional unit. Represents supervision and management
within the functional unit and the cost of all administrative activities
(e.g., secretarial, general administration, etc.). Also includes the
indirect costs for all activities performed within the basic organization
(which the functional unit is a part of) at all levels (both installation
and headquarters) to support the primary outputs of the particular
functional unit.

B3.3 Information Technology. Represents the cost of
hardware (including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources
that cannot be specifically and directly identified to a primary output.
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This includes all maintenance and repair, minor modifications and all U
replacement items (excluding initial purchase). Such costs are
incurred within the functional unit or the basic organization (which
the functional unit is a part of) at all levels (both installation and
headquarters). Normally these resources support two or more
primary outputs and cannot be traced easily or economically to
primary outputs. The costs of assets already purchased will only be
included when they are already being used or are planned to be sold
or used on another project. Non-cash charges such as depreciation U
and amortization are excluded.

B3.4 Facilities. Consists of all indirect costs involved in
owning, leasing and operating a facility that cannot be directly aiJ
solely identified to a specific primary output. Such costs are incurred
within the functional unit or the basic organization (which the I
functional unit is a part of) at all levels (both installation and
headquarters). Normally these resources support two or more
primary outputs and cannot be traced easily or economically to
primary outputs. It would include costs for construction (including
modification) if purchased, leasing costs if rented, appropriate utility U
charges, and repair and maintenance services (including land related).

The costs of assets already purchased will only be included when they
are already being used or are planned to be sold or used on another I
project. Non-cash charges such as depreciation are excluded.

B3.5 Materiel. Includes all indirect costs for purchases of 3
office furniture, equipment (non-computer), supplies including,
printing, and postage that cannot be directly identified to a primary
output. Such costs are incurred within the functional unit or the basic
organization (which the functional unit is a part of) at all levels (both
installation and headquarters). Normally these resources support two 3
or more primary outputs and cannot be traced easily or economically
to primary outputs. The costs of assets already purchased will only be
included when they are already being used or are planned to be sold i
or used on another project. Non-cash charges such as depreciation
are excluded. i

B3.6 Other. Includes all indirect costs other than labor which
support primary outputs such as general training, transportation, and
travel. Such costs are incurred within the functional unit or the basic
organization at all levels (both installation and headquarters) and
cannot be readily classified within any of the other five cost elements. 3
Non-cash charges such as depreciation are excluded.

I
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I B3.7 General Installation Support (General and
Administrative). Includes all indirect costs for activities performed by

Sinstallation organizations (other than the basic organization of the
functional unit) in support of the functional unit. It includes all the
major cost elements excluding information technology i.e. labor,I facilities, materiel, and other. Non-cash charges such as depreciation
and amortization are excluded.

3 B3.8 Headquarters Support of Installations. Represents the
indirect costs of major and intermediate commands, Service
headquarters, Office of Secretary of Defense, Joint Chiefs of Staff,
other Defense agencies, and functional headquarters at both the
Service and OSD levels.

B4. Disposal Phase. Represents the indirect costs of disposing assets
less the estimated salvage value or sales price.

B4.1 Civilian labor. Consists of the total civilian pay costs,
both gross pay and benefits, for all management, supervision and
administration for the functional unit. Represents supervision and
management within the functional unit and the cost of all
administrative activities (e.g., secretarial, general administration, etc.).
Also includes the indirect costs for all activities performed within the
basic organization (which the functional unit is a part of) at all levels
(both installation and headquarters) to support the primary outputs of
the particular functional unit.

B4.2 Military labor. Consists of the pay, including allowances
and retirement, for all management, supervision and administrationI for the functional unit. Represents supervision and management
within the functional unit and the cost of all administrative activities

S(e.g., secretarial, general administration, etc.). Also includes the
indirect costs for all activities performed within the basic organization
(which the functional unit is a part of) at all levels (both installation
and headquarters) to support the primary outputs of the particular
functional unit.

3 B4.3 Information Technology. Represents the cost of
hardware (including peripheral equipment), software, and related
telecommunications equipment purchased from commercial sources
that cannot be specifically and directly identified to a primary output.
Such costs are incurred within the functional unit or the basic
organization (which the functional unit is a part of) at all levels (both
installation and headquarters). Normally these resources support two
or more primary outputs and cannot be traced easily or economically
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to primary outputs. The costs of assets already purchased will only be I
included when they are already being used or are planned to be sold
or used on another project. Non-cash charges such as depreciation
and amortization are excluded.

B4.4 Facilities. Consists of all indirect costs involved in
owning, leasing and operating a facility that cannot be directly and
solely identified to a specific primary output. Such costs are incurred
within the functional unit or the basic organization (which the
functional unit is a part of) at all levels (both installation and
headquarters). Normally these resources support two or more
primary outputs and cannot be traced easily or economically to
primary outputs. It would include costs for construction (including
modification) if purchased, leasing costs if rented, appropriate utility
charges, and repair and maintenance services (including land related). I
The costs of assets already purchased will only be included when they
are already being used or are planned to be sold or used on another
project. Non-cash charges such as depreciation are excluded.

B4.5 Materiel. Includes all indirect costs for purchases of
office furniture, equipment (non-computer), supplies including,
printing, and postage that cannot be directly identified to a primary
output. Such costs are incurred within the functional unit or the basic 3
organization (which the functional unit is a part of) at all levels (both
installation and headquarters). Normally these resources support two
or more primary outputs and cannot be traced easily or economically
to primary outputs. The costs of assets already purchased will only be
included when they are already being used or are planned to be sold
or used on another project. Non-cash charges such as depreciation
are excluded.

B4.6 Other. Includes all indirect costs other than labor which U
support primary outputs such as general training, transportation, and
travel. Such costs are incurred within the funct~onal unit or the basic
organization at all levels (both installation and headquarters) and
cannot be readily classified within any of the other five cost elements.
Non-cash charges such as depreciation are excluded.

B4.7 General Installation Support (General and
Administrative). Includes all indirect costs for activities performed by 3
installation organizations (other than the basic organization of the
functional unit) in support of the functional unit. It includes all the
major cost elements excluding information technology i.e. labor,3
facilities, materiel, and other. Non-cash charges such as depreciation
and amortization are excluded. 3
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B4.8 Headquarters Support of Installations. Represents the
indirect costs of major and intermediate commands, Service
headquarters, Office of Secretary of Defense, Joint Chiefs of Staff,
other Defense agencies, and functional headquarters at both the
Service and OSD levels.

B5. Other Unique Phases (as required). Reserved for special or
unique types of activities that do not generally fit any of the other phases and
is of such significance to warrant separate accounting.
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I ABBREVIATIONS

I DDI Director of DoD Information

DMR Defense Management Review

DoD Department of Defense

FEAM Functional Economic Analysis Model

IDA Institute for Defense Analyses

RADCF Risk-Adjusted, Discounted Cash Flow

j RDT&E Research, Development, Test and Evaluation

TOA Total Obligational Authority
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